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Abstrak  

 
Kemampuan peserta di bidang teknologi yang sangat jauh tertinggal, tidak meratanya 

fasilitas pendukung TIK dan jumlah Sumber Daya Manusia (SDM) yang belum memadai 

dalam mendukung penerapan TIK adalah permasalahan yang dihadapi generasi muda di 

wilayah sekitar Lebak Jaya Pandeglang sehingga tim Abdimas merasa perlu untuk 

memberikan pelatihan animasi PowerPoint untuk meningkatkan kemampuan warga 

setempat khususnya generasi muda di bidang teknologi. Pelatihan dilaksanakan mulai dari 

Juni sampai dengan Juli 2022 di Laboratorium Komputer LKP BMC sebanyak tujuh kali 

pertemuan dan setiap pertemuan diberikan materi yang berbeda-beda. Hasil yang dicapai 

dalam pelatihan ini adalah: peserta sangat antusias dan termotivasi untuk mempelajari 

teknik-teknik animasi dan bahkan dapat membuat media pembelajaran animasi sendiri 

dengan teknik-teknik yang sudah diajarkan. Selain itu kemampuan peserta dalam 

mengoperasikan komputer meningkat sehingga memberikan rasa percaya diri kepada 

peserta 

 

Kata Kunci: Animasi, PowerPoint, Media Pembelajaran 

 

Abstract  

 
The ability of participants in the field of technology which is very far behind, the uneven 

distribution of ICT support facilities and the inadequate number of Human Resources (HR) 

to support the application of ICT are problems faced by the younger generation in the area 

around Lebak Jaya Pandeglang so the Abdimas team feels the need to provide training 

PowerPoint animation to improve the ability of local residents, especially the younger 

generation, in the field of technology. The training was held from June to July 2022 at the 

LKP BMC Computer Laboratory for seven meetings and each meeting was given different 

materials. The results achieved in this training are: participants are very enthusiastic and 

motivated to learn animation techniques and can even create their own animation learning 

media using the techniques that have been taught. In addition, the ability of participants to 

operate computers increased so as to give participants confidence 
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PENDAHULUAN  

 

Be Master Course and Training Institute (BMC) merupakan salah satu lembaga 

yang menaungi kegiatan masyarakat khususnya di wilayah Kadulisung. Terletak di Jl. 

Raya Labuan km. 5.1 Kadulisung atau tepat di depan MTsN Model Depan Pandeglang 
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1. Lembaga ini menawarkan beragam pelatihan kepada para peserta didik seperti, 

kursus bahasa Inggris, komputer aplikasi perkantoran, desain grafis, pemasaran digital, 

dan kursus matematika, dan juga menyelenggarakan kegiatan komunitas serta berfungsi 

sebagai pusat kegiatan pembelajaran masyarakat (PKBM). Lembaga BMC berdiri sejak 

tahun 2006 tepatnya tanggal 01 Januari 2006. Berkembang menjadi yayasan di bawah 

payung hukum akta notaris Keputusan Menteri Hukum dan Hak Asasi Manusia 

Republik Indonesia tanggal 20 April 2006. Nomor: C 143. HT.03.01 Th 2006. 

Dokumen ini diaktakan pada tanggal 8 September 2006 oleh Notaris Lalit Yuliati, SH. 

Adapun pendiri dari Lembaga ini adalah Bapak Acu dan Ibu Siti Masamah yang 

merupakan warga asli kampung Kadulisung. Lembaga Be Master Course memiliki misi 

yaitu meningkatkan kualitas Sumber Daya Manusia dengan mengembangkan 

keterampilan yang memungkinkan mereka menjadi kompeten di masa depan. Misi 

Institut adalah untuk memberikan pendidikan dan pelatihan berkualitas kepada individu 

sehingga mereka dapat memenuhi kebutuhan pasar yang selalu berubah, misinya 

adalah; 1. Salah satu cara untuk meningkatkan kreativitas dan inovasi mahasiswa adalah 

mempersiapkan mereka dengan kompetensi yang diperlukan di bidangnya. Dengan 

memberikan siswa keterampilan dan pengetahuan yang mereka butuhkan untuk sukses, 

mereka akan lebih mampu mengembangkan solusi kreatif dan inovatif untuk masalah; 

2. Peserta didik menerima pelatihan dalam keterampilan komputer, bahasa, dan 

matematika; 3. Kemampuan untuk bekerja secara mandiri atau dalam lingkungan 

DU/DI merupakan keterampilan yang penting untuk dikembangkan oleh peserta didik; 

4. Perlu adanya program pemerintah yang turut mencerdaskan anak bangsa. Program-

program ini memainkan peran penting dalam mempersiapkan anak-anak untuk masa 

depan dan membantu mereka sukses dalam hidup; 5. Penting untuk memberikan 

layanan pelanggan yang sangat baik kepada siswa untuk menciptakan lingkungan yang 

positif dan ramah. Sarana dan prasarana yang dimiliki Be Master Institution saat ini 

sudah lebih dari cukup, dengan fasilitas sebagai berikut: Ruang Teori dan Praktek, 

Projector/Infocus, Perpustakaan, Area Hotspot, Mushola, WC, Kantin, dan ruang 

belajar. Lembaga Be Master juga memiliki tujuan untuk memberikan berbagai pelatihan 

yang bermanfaat kepada warga sekitar untuk meningkatkan kesejahteraan dan tingkat 

sosial ekonomi mereka dengan memanfaatkan kearifan lokal daerah setempat. Oleh 

sebab itu tim dosen pengabdian masyarakat Universitas Indraprasta PGRI Jakarta 

terdorong untuk bermitra dengan Be Master dalam rangka melaksanakan pengabdian 

kepada masyarakat yang merupakan salah satu bagian dari Tridarma Perguruan Tinggi. 

Setelah melakukan survei dengan mitra kami, kami menemukan beberapa temuan. 

Pertama, Letak lembaga kursus dan pelatihan ini yang jauh dari pusat kota 

mengakibatkan kemampuan mahasiswa dalam bidang teknologi khususnya bidang 

Teknologi Informasi dan Komunikasi (TIK) yang sangat jauh tertinggal. Diakui secara 

luas bahwa Teknologi Informasi dan Komunikasi (TIK) memiliki dampak yang 

signifikan pada masyarakat di abad ke-21. Pengaruh TIK hadir dalam semua aspek 

kehidupan manusia, mulai dari ekonomi dan komunikasi sosial hingga politik dan 

pendidikan. (Helaluddin, 2019). Selain itu, berdasarkan rekomendasi World Economic 

Forum 2015, terdapat beberapa keterampilan abad 21 yang harus dikuasai masyarakat 

global. Beberapa keterampilan tersebut adalah literasi dasar, kompetensi dan karakter. 

Memperoleh keterampilan literasi dasar sangat penting bagi siswa dan pendidik untuk 

menjadi sukses dalam hidup. Salah satu kemampuan literasi dasar yang harus dikuasai 

siswa adalah Teknologi Informasi dan Komunikasi (TIK). Teknologi informasi dan 

komunikasi (TIK) adalah kemampuan untuk menggunakan teknologi digital, perangkat 
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komunikasi dan jaringan untuk mengakses, mengelola, mengintegrasikan, mengevaluasi 

dan membuat kelompok sosial. Mengingat pentingnya kemampuan ini, tidak ada alasan 

bagi siswa untuk ragu atau bimbang ketika menggunakan teknologi. 

Permasalahan berikutnya adalah belum meratanya persebaran infrastruktur yang 

mendukung penerapan TIK di wilayah ini. Infrastruktur merupakan elemen penting 

yang menyediakan landasan dan investasi awal untuk menerapkan TIK. Saat ini, ada 

kecenderungan hanya daerah tertentu saja yang memiliki akses TIK. Ada banyak area 

tanpa akses ke internet, mencegah orang menggunakan sumber daya ini. Padahal 

banyak sekali potensi sumber daya manusia unggul yang dimiliki oleh daerah. Jika 

kecenderungan ini terus berlanjut, dikhawatirkan sumber daya manusia di daerah tidak 

termanfaatkan secara maksimal, yang akan merugikan kemajuan bangsa Indonesia 

secara keseluruhan (Amin Akbar & Nia Noviani, 2019).  

Salah satu isu yang muncul adalah departemen Sumber Daya Manusia (SDM) 

tidak selalu siap mendukung penggunaan Teknologi Informasi dan Komunikasi (TIK).  

Hal ini disebabkan karena masih banyak tenaga pengajar di LKP BMC yang belum 

melek literasi digital dan masih belum tertarik untuk mempelajari TIK secara lebih 

mendalam. Kurangnya akses dalam memperoleh materi TIK juga menjadi alasan dari 

permasalah ini. Dari berbagai temuan tersebut di atas, tim PKM Unindra sepakat untuk 

memberikan keterampilan berupa Pelatihan Animasi Powerpoint Interaktif untuk 

Membuat Media Pembelajaran di LKP BMC Pandeglang dengan tujuan agar para 

generasi muda Pandeglang memiliki bekal yang dapat mereka manfaatkan pada saat 

mereka belajar, bekerja bahkan dapat membuka peluang usaha sehingga dapat 

meningkatkan kesejahteraan warga setempat.  

PowerPoint merupakan bagian dari Microsoft Office yang terdapat dalam program 

komputer. Aplikasi ini dirancang untuk membuat presentasi dengan berbagai format, 

antara lain PPT (PowerPoint Presentation dalam bentuk biner), PPS (PowerPoint 

Show), POT (PowerPoint Template, dan PPTX (PowerPoint Presentation dalam bentuk 

XML).  (Wahidah, 2017). Microsoft PowerPoint adalah program komputer yang sangat 

sukses yang semakin canggih, dengan fitur yang semakin lengkap (Darmawan, 2012 

dalam Wahidah, 2017). Hal ini juga didukung oleh Afandi (2017). Ia berpendapat 

bahwa Microsoft PowerPoint adalah perangkat lunak yang telah memfasilitasi 

penyusunan presentasi yang profesional, canggih, dan efektif. Microsoft PowerPoint 

dapat membantu membuat ide Anda lebih menarik dan mudah untuk dipahami. 

Microsoft PowerPoint merupakan perangkat lunak (software) yang digunakan 

sebagai media untuk presentasi berbagai kegiatan seperti presentasi pembelajaran, 

presentasi produk iklan, profil perusahaan, dan presentasi online. Media PowerPoint 

berisi beberapa jenis tulisan yang unik, efek suara, musik, video, serta efek gambar dan 

slide bergerak. Salah satu cara membuat media pembelajaran menggunakan PowerPoint 

adalah dengan memasukkan animasi, seperti masuk, penekanan, keluar, dan jalur gerak.  

Jika keempat fitur ini digabungkan akan menghasilkan animasi yang hidup dan menarik. 

Pergerakan elemen animasi dapat dikontrol melalui lima keyboard atau dengan 

mengklik gambar yang telah dirancang sebelumnya, menjadikan media pembelajaran 

lebih interaktif. Selain itu, slide dapat di-hyperlink ke slide lain atau software yang 

dapat diakses melalui website (Isroqmi, 2015). Hal yang sama juga disampaikan oleh 

Apriani (2018 dalam Dewi & Izzati, 2020) bahwa PowerPoint Interaktif adalah 

perpaduan antara fitur hyperlink dan suara sehingga terciptalah presentasi multimedia 

interaktif. Kombinasi hyperlink dan slide dapat digunakan untuk membuat presentasi 

interaktif yang memberi siswa kesempatan untuk menggunakan strategi kognitif yang 
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jauh lebih baik. Selain itu, PowerPoint juga bisa menjadi cara terbaik untuk 

menyampaikan humor pada siswa agar pembelajaran menjadi lebih menyenangkan dan 

tidak membosankan (Berk, 2014 dalam Dewi & Izzati, 2020).  

Menurut Hasanah (2020); Sanaky (2013 dalam Putri & Rezkita, 2019), beberapa 

kelebihan dari PowerPoint di antaranya: a. Memudahkan pengguna untuk presentasi. b. 

Dilengkapi beragam tools seperti text art, image import, animation report, video import, 

dan yang lainnya sehingga tampilannya menjadi menarik. c. Adanya template bervariasi 

(Salah satu fitur dalam PowerPoint yang membuat latar menjadi sangat menarik.) d. 

Terdapat fitur kolaborasi yang memungkinkan pengguna untuk mengedit file presentasi 

dari komputer yang berbeda secara bersamaan. e. Ruang penyimpanan memiliki fitur 

Cloud sebelum pengguna meletakkannya di ruang penyimpanan local (Local Storage). f. 

Berisi fitur authoring yang melindungi dokumen dari pihak yang tidak bertanggung 

jawab. Memiliki teknik penyajian yang menarik sehingga para peserta termotivasi untuk 

memperhatikan materi presentasi.  

Sedangkan menurut Hasanah (2020); Sanaky (2013 dalam Putri & Rezkita, 2019), 

beberapa kelemahan dari software PowerPoint adalah sebagai berikut: a. Hanya bisa 

digunakan pada Microsoft Office. b. Memerlukan peralatan khusus untuk 

memproyeksikan pesan yaitu komputer atau laptop dan LCD proyektor. c. 

Membutuhkan persiapan yang matang dan terencana, terutama ketika teknik kinerja 

yang kompleks (teknik animasi) digunakan. d. Diperlukan keterampilan khusus untuk 

menyampaikan gagasan atau ide yang bagus ke desain PowerPoint dengan cara yang 

mudah dipahami.  

Berdasarkan uraian di atas, maka tim Abdimas UNINDRA PGRI mengadakan 

“Pelatihan Animasi PowerPoint Interaktif” yang diharapkan dapat membantu para 

remaja dalam meningkatkan keterampilannya. Selain itu tim juga akan memasukkan 

kearifan lokal daerah setempat sebagai bahan materi dalam membuat konten media 

pembelajaran atau konten media sosial lainnya sehingga dapat memperkenalkan kota 

Pandeglang sebagai alternatif destinasi wisata kepada masyarakat luas. Diharapkan 

dengan banyaknya wisatawan yang datang ke kota Pandeglang akan meningkatkan 

pendapatan masyarakat setempat pula. Selain itu dengan pelatihan animasi ini 

diharapkan dapat meningkatkan motivasi siswa dalam belajar dan memberikan alternatif 

teknik mengajar yang menarik kepada para peserta didik. 

 

 

METODE PELAKSANAAN  
 

Kegiatan pengabdian kepada masyarakat ini dilaksanakan dengan memberikan 

pelatihan langsung kepada mahasiswa di LKP BMC tentang bagaimana cara 

mengoperasikan Powerpoint Interaktif sehingga mampu membuat animasi sederhana. 

Ini akan membantu mereka membuat konten di media sosial yang memperkenalkan 

budaya dan tradisi lokal. Tim Pengabdian Kepada Masyarakat Universitas Indraprasta 

meminta kepada LKP BMC agar peserta diberikan sosialisasi terlebih dahulu tentang 

Pelatihan Powerpoint Interaktif LKP BMC dan menjelaskan manfaat pelatihan ini untuk 

meningkatkan keterampilan dan kreativitas mereka. Semua peserta diberikan 

kesempatan untuk berpartisipasi dalam pelatihan tanpa dipungut biaya. Pelatihan 

dilaksanakan pada bulan Juni hingga Juli 2022 di Laboratorium Komputer LKP BMC 

selama tujuh kali pertemuan dan setiap pertemuan diberikan materi tentang teknik 

animasi yang berbeda. 
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Pelatihan juga diadakan di waktu libur sehingga tidak mengganggu waktu belajar 

mereka. Mereka juga diberikan modul secara cuma- cuma sehingga mereka dapat 

mempelajari Powerpoint Interaktif ini di rumah mereka masing-masing. Tempat 

pelatihan juga dilaksanakan di laboratorium komputer LKP BMC agar seluruh peserta 

dapat mempraktekkan materi yang dipelajari secara langsung. Adapun metode yang 

diterapkan dalam pelatihan adalah metode ceramah dengan menggunakan alat In Focus 

dan pada saat yang bersamaan, peserta diminta juga ikut mempraktekkan materi yang 

diberikan di komputer mereka masing-masing. 

 

 

HASIL DAN PEMBAHASAN   
 

Hasil Pelatihan  

 

Pelatihan animasi PowerPoint untuk membuat animasi media pembelajaran ini 

dilaksanakan selama 8 minggu mulai dari bulan Juni sampai dengan Juli 2022.  Selama 

8 minggu tersebut, peserta diberikan materi-materi yang berbeda setiap minggunya 

karena untuk mempelajari satu materi saja diperlukan waktu yang cukup lama untuk 

mempelajari dan menguasainya. Ini karena untuk menguasai satu teknik animasi saja 

harus melalui beberapa tahapan yang berbeda. Mengingat tingkat kesulitan dari materi 

yang diberikan cukup tinggi maka waktu yang diberikan setiap kali pertemuan adalah 3 

jam. Jumlah peserta yang mengikuti pelatihan ini adalah 15 orang dan merupakan para 

remaja sekolah tingkat menengah dan atas. Semua peserta harus dapat mengoperasikan 

komputer dan mengikuti instruksi bahasa Inggris dasar seperti menyimpan, mencari, 

mengunggah, memangkas, membentuk, menghapus, dan menyalin. Sehingga peserta 

dapat lebih cepat memahami materi, mengingat terbatasnya waktu yang tersedia. 

Para peserta selalu bersemangat mengikuti pelatihan setiap minggunya, karena 

selalu belajar hal-hal baru. Para peserta juga termotivasi oleh fakta bahwa pelatihan ini 

dilakukan dengan pendekatan multimodal sehingga lebih menarik dan menarik.  Setiap 

minggunya, peserta diminta membuat satu karya animasi menggunakan teknik yang 

dipelajari dan setiap kali peserta selesai membuatnya, mereka terlihat sangat puas dan 

senang karena karyanya menjadi lebih hidup setelah diberikan teknik animasi. Di akhir 

pelatihan, peserta diminta membuat satu media pembelajaran dari materi pelajaran di 

sekolah dengan menggunakan teknik animasi dari PowerPoint Interaktif. Dari 15 karya, 

terlihat ada tiga buah karya animasi media pembelajaran terbaik yang sudah dibuat 

dalam bentuk video. Tiga buah karya terbaik tersebut adalah:   

1. Animasi media pembelajaran terbaik pertama, bertema: Asking and Giving 

Directions.  

2. Animasi media pembelajaran terbaik kedua, bertema: Ketenagakerjaan di 

Indonesia.  

3. Animasi media pembelajaran terbaik ketiga, bertema: In the Zoo.  

Untuk mengapresiasi usaha dan karya dari para peserta terbaik ini, tim Abdimas 

memberikan hadiah masing-masing berupa piagam penghargaan, buku panduan 

Penggunaan PowerPoint Interaktif Dalam Membuat Media Pembelajaran Bahasa 

Inggris, Agenda dan Cindera Mata. Bagi para peserta lainnya, tim Abdimas memberikan 

cindera mata berupa buku agenda dan alat tulis yang dapat mereka gunakan pada saat 

bersekolah. Ketiga video animasi media pembelajaran terbaik ini kemudian 

dipertunjukkan di acara penutupan dan mendapat sambutan yang cukup meriah dari 
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para tokoh masyarakat setempat. Mereka sangat bangga karena para remaja di wilayah 

mereka dapat membuat sebuah karya yang tidak kalah bagusnya dari video animasi lain 

yang sudah menggunakan aplikasi yang lebih canggih. Selain itu beberapa video 

animasi media pembelajaran dari para peserta juga diunggah di website LKP BMC 

sebagai bentuk media promosi lembaga serta mensosialisasikan pelatihan ini ke 

masyarakat luas. 
 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

Gambar 1 Bersama Pengurus dan Staff LKP BMC 

 

Pembahasan 

 

Temuan dari penelitian tentang efikasi pelatihan animasi PowerPoint untuk media 

pembelajaran animasi menunjukkan bahwa para peserta belum pernah mendapatkan 

instruksi sebelumnya tentang cara membuat animasi menggunakan PowerPoint. 

Maklum, hal ini menyebabkan kesulitan menangkap konsep yang diajarkan pada 

pertemuan pertama dan kedua. Namun, pada pertemuan ketiga, peserta sudah lebih 

nyaman dengan materi tersebut. Tahapan teknik animasi PowerPoint adalah sebagai 

berikut: 

1. Memunculkan dan Menghilangkan Gambar  

a. Memunculkan gambar  

 Klik objek gambar → klik Animations → Pilih di bagian Entrance (atau yang 

berwarna hijau) → klik Fade (atau animasi lain yang anda inginkan). Setelah itu 

rubah Start ke After Previous.  

 Untuk beberapa jenis animasi memunculkan gambar seperti: Fly In, Float In, 

Bounce dan lain-lain, anda juga bisa mengatur arah munculnya gambar. Langkah-

langkahnya adalah: klik Animations→ Pilih di bagian Entrance (atau yang 

berwarna hijau) → klik Fly in, Float In, Bounce atau animasi lain yang anda 

inginkan → Effect Options → Directions → Pilih arah yang diinginkan.  

  

b. Menghilangkan gambar klik objek gambar → Animations → Add Animations → 

pilih di bagian Exit (atau yang berwarna merah) → klik Fade (animasi lain yang 

diinginkan). Setelah itu rubah Start ke After Previous.  

 Untuk beberapa jenis animasi menghilangkan gambar seperti: Fly Out, Float Out, 

Bounce dan lain-lain, anda juga bisa mengatur arah munculnya gambar. Langkah-

langkahnya adalah: klik Animations→ Pilih di bagian Entrance (atau yang 
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berwarna hijau) → klik Fly Out, Float Out, Bounce atau animasi lain yang anda 

inginkan → Effect Options → Directions → Pilih arah yang diinginkan. 
 

 

 

 

 

 

 

 

 

 

 
 

Gambar 2 Instruksi Memunculkan dan Menghilangkan Gambar 

 

2. Menggerakkan Gambar  

a. Menggerakkan gambar ke tiap arah  

Teknik ini bertujuan agar gambar yang kita aplikasikan didalam slide bisa 

bergerak ke segala arah sehingga slide lebih terlihat hidup dan menarik.   

•  Pertama-tama, Letakkan objek gambar di luar slide, misalnya sebelah kiri.  

• Klik objek gambar → klik Animations → klik tanda panah ke bawah → klik 

more motion path → Right → OK.  

• Setelah itu akan terlihat bulatan berwarna merah. Tempatkan mouse ke bulatan 

tersebut hingga membentuk panah kemudian klik kanan mouse, tahan dan tarik 

ke sebelah kanan terus hingga menuju ke tengah atau luar slide (sesuai 

keinginan). Selanjutnya rubah Start Ke After Previous dan setting Duration ke 

angka 05,00 agar objek berjalan tidak terlalu cepat.  

• Apabila objek gambar berada di sebelah kanan maka Langkah-langkahnya 

kurang lebih sama saja. Klik objek gambar → klik Animations → klik tanda 

panah ke bawah → klik more motion path → Left → OK.  

• Setelah itu akan terlihat bulatan berwarna merah. Tempatkan mouse ke bulatan 

tersebut hingga membentuk panah kemudian klik kanan mouse, tahan dan tarik 

ke sebelah kanan terus hingga menuju ke tengah atau luar slide (sesuai 

keinginan). Selanjutnya rubah Start Ke After Previous dan setting Duration ke 

angka 05,00.  

• Untuk membuat objek gambar bergerak dari atas ke bawah maka 

Langkahlangkahnya adalah pertama-tama Letakkan objek gambar di luar slide, 

bagian atas. Klik objek gambar → klik Animations → klik tanda panah ke 

bawah → klik more motion path → Down → OK.  

• Setelah itu akan terlihat bulatan berwarna merah. Tempatkan mouse ke bulatan 

tersebut hingga membentuk panah kemudian klik kanan mouse, tahan dan tarik 

ke bawah terus hingga menuju ke tengah atau luar slide (sesuai keinginan). 

Selanjutnya rubah Start Ke After Previous dan setting Duration ke angka 

05,00.  

• Sedangkan untuk membuat objek gambar bergerak dari bawah ke atas maka 

Langkah-langkahnya adalah pertama-tama Letakkan objek gambar di luar 
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slide, bagian bawah. Klik objek gambar → klik Animations → klik tanda 

panah ke bawah → klik more motion path → Up → OK.  

• Setelah itu akan terlihat bulatan berwarna merah. Tempatkan mouse ke bulatan 

tersebut hingga membentuk panah kemudian klik kanan mouse, tahan dan tarik 

ke atas terus hingga menuju ke tengah atau luar slide (sesuai keinginan). 

Selanjutnya rubah Start Ke After Previous dan setting Duration ke angka 

05,00.  
  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Gambar 3 Instruksi Menggerakkan Gambar 

 

b. Menggerakkan dua objek gambar atau lebih secara serentak.  

Adapun langkah-langkah untuk memindahkan objek gambar dari kiri atau 

kanan hampir sama dengan Teknik sebelumnya, namun ada sedikit perbedaan. 

Misalnya, kami ingin memindahkan dua gambar Bajaj secara bersamaan. 

• Maka pertama-tama kita tempatkan dua buah gambar ini di luar slide.  

• Setelah itu kita bisa mulai menambahkan animasi ke salah satu objek gambar 

tersebut. Apabila kita menambahkan animasi pertama ke gambar sebelah kiri 

maka langkah-langkahnya sama seperti langkah-langkah menggerakkan 

gambar dari kiri ke kanan. Sedangkan gambar di sebelah kanannya mengikuti 

langkah-langkah sebagai berikut:   

• Klik objek gambar → klik Animations → klik tanda panah ke bawah → klik 

more motion path → Right → OK.   

• Setelah itu akan terlihat bulatan berwarna merah.   

• Tempatkan mouse ke bulatan tersebut hingga membentuk panah kemudian klik 

kanan mouse, tahan dan tarik ke sebelah kanan terus hingga menuju ke tengah 

atau luar slide (sesuai keinginan).   
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• Selanjutnya rubah Start Ke With Previous dan setting Duration ke angka 

05,00. 

• Begitu pula sebaliknya apabila kita menambahkan animasi ke gambar sebelah 

kanan terlebih dahulu maka Langkah-langkahnya sama seperti kita 

menggerakkan gambar dari kanan ke kiri. Namun untuk gambar di sebelah kiri 

maka fitur Startnya harus dirubah ke With Previous. 

 

3. Menggabungkan dua objek gambar atau lebih  

Sebagai contoh kita akan menggabungkan objek gambar dengan tulisan.   

• Pertama-tama letakkan objek gambar di slide kosong kemudian klik insert → 

Word Art → pilih model tulisan yang diinginkan.  

• Ketik tulisan di kolom yang tersedia kemudian tempatkan di tengah gambar 

papan rambu.  

• Klik tulisan → tekan tombol Shift di Laptop dan tahan → klik gambar papan 

rambu →Shape Format → Group. Hasilnya papan rambu dan tulisan akan 

menyatu dan tidak akan terpisah pada saat digeser-geser.  

Kita menggunakan Langkah-langkah yang sama dalam menggabungkan objek 

gambar yang berjumlah lebih dari dua.  
 

 

 

 

 

 

 

 

 
 

 

 

 

 

Gambar 4 Instruksi Menggabungkan Gambar 

  

4. Memasukkan Suara  

• Klik Insert → Audio → kalau anda ingin merekam suara sendiri klik Record 

Audio (Lihat penjelasan saya tentang bagaimana merekam suara sendiri 

dengan Powerpoint) sedangkan kalau anda sudah ada file efek suaranya, anda 

tinggal klik Audio on my PC. Setelah itu akan terlihat lambang speaker.   

• Klik lambang speaker kemudian klik Playback →Hide During Show agar 

lambangnya tidak terlihat pada saat ditampilkan.  

• Klik lambang speaker sekali lagi → klik Animations → rubah Start menjadi 

After Previous. 

Agar tampilan animasi PowerPoint ini lebih menarik, Anda bisa memasukkan 

unsur musik ke dalamnya. Musik background ini bisa kita atur agar terus berbunyi 

dari slide pertama sampai slide terakhir tanpa henti. Tahapannya adalah sebagai 

berikut: 
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• Unduh terlebih dahulu efek musik yang anda inginkan dari website yang 

menawarkan efek music tidak berbayar.  

• Klik Insert → Audio → klik Audio on my PC → pilih efek music → klik Insert 

→ Setelah itu akan terlihat lambang speaker.  

• Klik lambang speaker kemudian klik Playback →Hide During Show agar 

lambangnya tidak terlihat pada saat ditampilkan. 

• Klik lambang speaker sekali lagi → klik Animations → rubah Start menjadi 

After Previous.  

• Buka jendela Animation Pane dengan cara: Klik Animation → Animation Pane 

→ akan terbuka jendela Animation Pane di sebelah kanan.  

• Klik lambang speaker → di jendela Animation Pane, lambang speaker akan 

terlihat garis berwarna merah → klik tanda panah ke bawah dan pilih Timing 

→ akan terbuka jendela Play Audio di tengah.  

• Di jendela Play Audio lihat di bagian Repeat → Pilih Until End of Slide → Ok. 
 

 

 

 

 
 

 

 

 

 

 
Gambar 5 Instruksi Memasukkan Suara 

 

5. Memotong dan Mengedit Video.  

Seringkali dalam membuat media pembelajaran keterampilan mendengarkan 

(listening), kita memasukkan audio berupa percakapan atau ceramah yang berasal 

dari CD. Dalam 1 track kadang terdapat beberapa dialog dan untuk keperluan 

pembuatan media, kita diharuskan untuk memisahkan dialog-dialog tersebut agar 

dapat dimasukkan pada slide terpisah. Dalam Powerpoint, sudah ada fitur yang dapat 

membantu kita dalam memotong atau mengedit audio. Berikut langkah-langkahnya:  

• klik audio → Playback → klik Trim Audio  

• Setelah itu akan muncul jendela Trim Audio.  

• Geser penggaris hijau dan merah untuk mendapatkan dialog atau bagian audio 

yang diinginkan kemudian klik OK.  

  

6. Memunculkan tulisan huruf per huruf atau kata per kata  

Sebagai contoh saya akan menggunakan papan rambu bertuliskan Asking and 

Giving Direction yang cara pembuatannya sudah dijelaskan sebelumnya namun 

jangan di gabungkan terlebih dahulu.  

• Pertama-tama, klik tulisan tersebut → klik Animations → Pilih salah satu animasi 

yang berwarna hijau (misalnya, Fade).  
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• Di menu Animations → klik menu Animation Pane → akan muncul jendela 

Animation Pane di Sebelah Kanan.  

• Klik tulisan kemudian akan terlihat bagian tulisan tersebut mendapat garis 

berwarna merah di jendela Animation Pane. Klik tanda panah yang berada di 

sebelah kanan dan pilih menu Effect Options.  

• Setelah kita klik Effect Options akan muncul jendela lagi dan lihat di bagian 

Animate text → pilih by letter (kalau ingin muncul huruf per huruf) atau pilih by 

word (kalau ingin muncul kata per kata) → klik OK.  

• Terakhir rubah Start ke After Previous dan untuk melambatkan ubah setting 

Duration ke 05,00. 
 

 

 

 

 

 

 

 

 

 
 

 

 

Gambar 6 Instruksi munculkan Tulisan Huruf per Huruf 

 

Dari pelatihan tersebut, peserta mengalami perkembangan yang cukup 

menarik. Di hari pertama, kedua dan ketiga, terlihat bahwa peserta mengalami 

kesulitan. Hal ini disebabkan karena peserta jarang mengoperasikan komputer karena 

Sebagian besar dari mereka tidak memiliki komputer di rumah. Oleh sebab itu tim 

Abdimas terpaksa harus menjelaskan terlebih dahulu menu-menu yang terdapat 

dalam PowerPoint dan beberapa instruksi komputer dalam Bahasa Inggris. 

Penjelasanpun terpaksa harus dilakukan berulangkali karena sebagian peserta tidak 

mengingat urutan tahapan yang harus dilakukan.  
 

 

 

 

 

 

 

 

 

 

 

 

 
 

Gambar 7 Suasana Selama Pelatihan 
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Walaupun peserta mengalami kesulitan namun mereka terlihat sangat antusias 

untuk mempelajarinya karena pelatihan ini menggunakan gambar-gambar yang 

mereka cari sendiri di internet dan sesuai dengan apa yang mereka sukai. Pada saat 

mereka berhasil menguasai teknik animasi yang dipelajari, mereka sangat puas dan 

senang serta termotivasi untuk mempelajari teknik lain. 

Di hari keempat dan kelima peserta terlihat mulai terbiasa dengan 

tahapantahapan yang harus dilakukan karena mereka sudah mulai menguasai menu-

menu yang terdapat dalam aplikasi PowerPoint. Selain itu, mereka sudah mulai 

terbiasa dengan tahapan-tahapan yang harus dilakukan karena pada dasarnya 

tahapan-tahapan tersebut adalah pengulangan dari tahapan-tahapan yang sudah 

mereka pelajari di hari sebelumnya.   
 

 

 

 

 

 

 

 

 

 

 
 

 

Gambar 8 Suasana Selama Pelatihan 

 

Di hari keenam dan ketujuh peserta sudah mulai lancar mengikuti materi yang 

diberikan dan mereka sudah mengingat setiap tahapan yang diajarkan. Bahkan 

mereka sudah mulai dapat mengkombinasikan beberapa teknik animasi sehingga 

menghasilkan video animasi yang cukup menarik dan lucu. Di hari ketujuh ini, 

peserta terlihat lebih antusias dari sebelumnya karena mereka diminta untuk 

membuat video animasi media pembelajaran dari materi pelajaran yang mereka 

dapatkan di sekolah. Dengan membuat media pembelajaran ini, diharapkan peserta 

lebih termotivasi untuk belajar dan juga dapat membagi pengetahuan dengan teman-

teman lain melalui media ini.   

Di akhir kegiatan, Peserta pelatihan Animasi Powerpoint Interaktif Pembuatan 

Media Pembelajaran di LKP BMC Lebak Jaya Pandeglang merasa kegiatan ini 

bermanfaat dan mereka termotivasi karenanya. Hal ini ditandai dengan semangat 

mereka yang tinggi untuk mempelajari dan mempraktekkan proses pembuatannya 

secara bertahap. Mereka juga terlihat sangat termotivasi dalam mengikuti pelatihan 

ini dan merasa bahwa pelatihan ini sangat bermanfaat dalam meningkatkan 

kemampuan mereka di bidang teknologi. Oleh sebab itu mereka berharap pelatihan 

ini dapat dilakukan secara berkesinambungan dengan memberikan pelatihan-

pelatihan lain yang dapat meningkatkan wawasan pengetahuan mereka. Berikut 

adalah hasil wawancara tim pengabdian masyarakat dengan peserta sehubungan 

pendapat mereka tentang manfaat kegiatan ini:  

a Pengetahuan peserta dalam bidang teknologi khususnya komputer semakin 

bertambah  
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b Meningkatkan motivasi mereka dalam mempelajari komputer lebih dalam lagi.  

c Menambah pengetahuan peserta dalam membuat animasi dengan menggunakan 

PowerPoint.  

d Meningkatkan kreativitas mereka dalam berkarya membuat animasi yang dapat 

memperkenalkan budaya setempat.  

e Tertarik untuk mempelajari lebih banyak lagi keterampilan mengoperasikan 

aplikasi komputer. 

 

 

SIMPULAN  
 

Kegiatan pengabdian masyarakat ini disambut baik oleh para mitra kami di 

Lembaga Pelatihan Be Master serta oleh pemangku kepentingan masyarakat di wilayah 

desa Lebak Jaya. Pelatihan tersebut telah membantu masyarakat, khususnya kaum 

muda, memperoleh keterampilan dalam teknologi yang akan meningkatkan prospek 

mereka untuk mencari pekerjaan atau memulai usaha sendiri. Setelah pelatihan ini 

berakhir, terlihat adanya hasil yang signifikan, seperti (1) peserta dapat mempraktekkan 

materi tentang teknik animasi PowerPoint dengan benar sesuai dengan instruksi yang 

diberikan (2) peserta mempelajari hal baru tentang teknologi dan termotivasi untuk 

menggunakan teknik ini dalam membuat konten di media sosial maupun membuat 

media pembelajaran (4) peserta termotivasi untuk mempelajari lebih lanjut teknik-

teknik animasi lain dengan menggunakan PowerPoint (5) pihak mitra yaitu LKP BMC 

termotivasi untuk menyebarluaskan teknik animasi PowerPoint ini ke kalangan guru dan 

tenaga pengajar agar mereka dapat mempraktekannya dalam mengajar peserta didik. 

Berdasarkan hasil evaluasi dari kegiatan ini, ada beberapa hal yang perlu 

diperbaiki dan juga masukan dari berbagai pihak sehingga pada kegiatan berikutnya, 

pelaksanaannya dapat berlangsung dengan lebih baik lagi. Adapun masukan tersebut 

adalah: 

1. Perlu adanya pelatihan yang berkesinambungan dan dengan materi yang berbeda 

sehingga peserta tidak mudah lupa akan materi yang sudah diberikan dan 

pengetahuan peserta dalam mengoperasikan komputer semakin bertambah.  

2. Perlu adanya sosialisasi yang lebih luas lagi sehingga dapat menjangkau lebih 

banyak peserta yang ingin meningkatkan kemampuannya di bidang komputer.  

3. Perlu adanya bantuan dari pemerintah daerah setempat untuk memberikan fasilitas 

pendukung TIK yang memadai bagi masyarakat Pandeglang khususnya di daerah 

Kadulisung sehingga dapat dimanfaatkan secara maksimal oleh masyarakat setempat 

khususnya generasi muda Pandeglang. 

4. Para peserta pelatihan diharapkan dapat terus berkarya membuat video-video animasi 

yang memperkenalkan kearifan lokal daerah setempat sehingga dikenal oleh 

masyarakat luas. 
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